
Welcome to GIF Construction Set Professional’s Help. The information in the 
help selection is a subset of what is available in the Manual installed with your
software. If you don’t find what you need here, or if you require additional 
clarification, please consult the Manual and its dependent documents.

IMPORTANT: The GIF Construction Set Professional Help function 
consists of a subset of the complete GIF Construction Set 
documentation. For a more thorough discussion of the features of 
this application, please see the Manual document and its dependent 
documents, installed with GIF Construction Set Professional. Double-
click on the Manual icon, or select Manual from the GIF Construction 
Set Professional section of the Windows Programs menu.

          Help with Configuring GIF Construction Set Professional  

          Help with Using GIF Construction Set Professional  

          Help with Registering GIF Construction Set Professional  

          Help with Contacting Alchemy Mindworks  



Configuration and Setup

The GIF Construction Set Setup dialog can be accessed by clicking on the 
Setup button in the tool bar or by selecting Setup from the File menu. Because
there are a lot of format variations and other things you're likely to want to 
change periodically, you should become familiar with Setup.

Setup is organized into a number of panels to make it easier to locate the 
Setup item you need to change.

          The Display Panel  
          The Files Panel  
          The Register Panel  



The Display Panel

Default View Mode: This item sets the default view mode for new document
windows.
Display Interlaced: If this switch is enabled, image blocks with interlaced 
images will display in interlaced order in View windows.
Interlace Delay: This item sets the number of thousandths of a second to 
wait between lines when an interlaced image is displayed. This value will be 
ignored if the Display Interlace item is not enabled. Animated graphics don't 
display as interlaced.
Maximize Paint: Enable this item to cause the Windows Paint to be 
maximized when it's called from an Image block editor. Disable it to allow 
Windows Paint to open normally.

Optimum Vertical Windows: Enable this item to have GIF Construction Set's
document windows adjusted to use as much of the vertical window space as 
possible. Disable it to have them created at the default size for a document 
window. Note that if this item is enabled, the default vertical window size will 
leave a gap between it and the bottom of the GIF Construction Set application 
window to allow for minimized documents.

Show Startup Window: Enable this item to have the startup logo window 
displayed when GIF Construction Set boots up.

Show Tip of the Day: Enable this item to have the tip of the day displayed 
when GIF Construction Set boots up.

Warn Before Deleting Multiple Blocks: Enable this item to be warned if 
you click on the Delete button or hit Del when you have multiple blocks 
selected in a document window.
Warn for Remove By Errors: Enable this item to be warned if you attempt 
to create or edit a GIF file with one or more remove-by fields set 
inappropriately for the transparency effects you've selected.

Warn for Remove By Previous Image: Enable this item to be warned if you
attempt to create or edit a GIF file with one or more remove-by fields set 
incorrectly.
Warn for Wait for User Input: Enable this item to be warned if you attempt 
to create or edit a GIF file with one or more Wait for User Input flags selected.



The Files Panel

Anti-alias Density: This item sets the degree of aggressiveness with which 
GIF Construction Set will apply anti-aliasing in those functions for which it's 
available. Increasing this value will increase the degree of anti-alias 
compensation.
AVI Quality Factor: This item sets the quality factor for writing AVI files. It 
can range from 100 for unspeakably ugly to 10000 for almost perfect 
reproduction.

Default Palette: This item sets the initial palette size for the header of blank 
GIF files created with the New function of the File menu. There are a number 
of palette options. 

256 colours: This palette has an even dispersal of colours between 
black and white.
256 colours with grey: This palette has an even dispersal of colours 
between black and white, but it includes 32 levels of grey.
216 colours/safe: This is the palette web browsers use to remap 
colour images to for a 256-colour machine.
32, 64 and 128 colours: These are evenly dispersed palettes. The 
32-colour palette is a bit deficient in blues.
16 colours: This is the sixteen-colour Windows palette.

2 colours: This palette includes all the colours of the rainbow, 
provided they're black and white.

Fast colour matching: If this switch is enabled, GIF Construction Set will use 
colour matching which is fast, but less accurate. Disable this switch for better 
dithering and closer colour matches.
Identify Files: If this option is enabled, GIF Construction Set will add a 
comment block to each GIF file it writes. The comment block will identify of 
the owner of the copy of GIF Construction Set that wrote the file. If you're a 
registered user of the software, this will be your registration name and the 
company you work for, as entered when you installed Windows. If you're using
an unregistered copy of GIF Construction Set, this will be your name and 
company as entered when you installed Windows, or a message stating that 
this information could not be found. Alternately, you can supply your own text 
for this block. See the discussion of Identification Text File.

Identification Text File: You can configure GIF Construction Set to add a 
Comment block with your choice of text in it to every file you create. To do 
this, create your text in a plain ASCII text file using the Windows Notepad 
application. Save the file in your GIF Construction Set Professional parent 
directory. Having done so, select this file using the Browse button of the 
Identification Text File field. Make sure the Identify Files option has been 
enabled.
The text file pointed to by Identification Text File must be plain ASCII text, not 
a word processor document. It can contain up to 16000 characters, although 



few users of your GIF files will thank you for including anything like this much 
comment text in them. Tabs will be replaced by single spaces.
JPEG Quality: This item defines the degree of detail loss used when exporting
images to the JPEG format – this applies to functions such as the Button 
creator. Reduce this value to create smaller JPEG files, and increase it to make 
the graphics stored in them look more attractive.

Search for Paintbrush: If this item is enabled and Windows Paint – the 
MSPAINT.EXE file – is not found when GIF Construction Set boots up, the 
software will search your had drive for it. Disable this item if Windows Paint is 
not on your system. Note that if you have Windows Paint on your system, and 
GIF Construction Set has located it, this item will be ignored.
Write Compressed AVI Files: Enable this item to have the GIF to Movie 
feature of GIF Construction Set write compressed AVI files. See Movies for 
more about this option. Disable this item if you'll be creating AVI files to use 
with Visual BASIC, which can only accept uncompressed AVI files as of this 
writing.

Write Directory Blocks: Enable this item to have GIF Construction Set 
preserve the titles of the image blocks in your GIF file in a Block Title. Block 
Title blocks are written after all the other blocks in a GIF file. They're is helpful 
in keeping track of the images in an animation sequence, for example. This 
item should be disabled if you're creating final GIF files for use on web pages, 
as Block Title blocks will increase the size of your GIF files.

Write Uncompressed GIF Files: Enable this item to have GIF Construction 
Set store all the images in the GIF files it creates uncompressed. Such files are
legal GIF files, and can be read by other GIF readers. However, they embody 
no LZW compression – they can also be read by LZW-free GIF readers. Note 
that uncompressed GIF files will typically be larger than their raw image data 
by a considerable margin. Unless you have a good reasons for doing 
otherwise, leave this item off.



Default View Mode: This item sets the default view mode for new document 
windows.



Display Interlaced: If this switch is enabled, image blocks with interlaced images 
will display in interlaced order in View windows.



Maximize Paint: Enable this item to cause the Windows Paint to be maximized 
when it's called from an Image block editor. Disable it to allow Windows Paint to 
open normally.



Optimum Vertical Windows: Enable this item to have GIF Construction Set's 
document windows adjusted to use as much of the vertical window space as 
possible. Disable it to have them created at the default size for a document window.
Note that if this item is enabled, the default vertical window size will leave a gap 
between it and the bottom of the GIF Construction Set application window to allow 
for minimized documents.



Show Startup Window: Enable this item to have the startup logo window 
displayed when GIF Construction Set boots up.



Show Tip of the Day: Enable this item to have the tip of the day displayed when 
GIF Construction Set boots up.



Warn Before Deleting Multiple Blocks: Enable this item to be warned if you 
click on the Delete button or hit Del when you have multiple blocks selected in a 
document window.



Warn for Remove By Errors: Enable this item to be warned if you attempt to 
create or edit a GIF file with one or more remove-by fields set inappropriately for 
the transparency effects you've selected.



Warn Before Displaying Manual: Enable this item to have GIF Construction Set 
display a prompt before its on-line manual appears.



Warn for Remove By Previous Image: Enable this item to be warned if you 
attempt to create or edit a GIF file with one or more remove-by fields set incorrectly.



Warn for Wait for User Input: Enable this item to be warned if you attempt to 
create or edit a GIF file with one or more Wait for User Input flags selected.



Anti-alias Density: This item sets the degree of aggressiveness with which GIF 
Construction Set will apply anti-aliasing in those functions for which it's available. 
Increasing this value will increase the degree of anti-alias compensation.



Default Palette: This item sets the initial palette size for the header of blank GIF 
files created with the New function of the File menu. There are a number of palette 
options. 

256 colours: This palette has an even dispersal of colours between black and 
white.

256 colours with grey: This palette has an even dispersal of colours between 
black and white, but it includes 32 levels of grey.

216 colours/safe: This is the palette web browsers use to remap colour images
to for a 256-colour machine.

32, 64 and 128 colours: These are evenly dispersed palettes. The 32-colour 
palette is a bit deficient in blues.

16 colours: This is the sixteen-colour Windows palette.
2 colours: This palette includes all the colours of the rainbow, provided they're 
black and white.



Identify Files: If this option is enabled, GIF Construction Set will add a comment 
block to each GIF file it writes. The comment block will identify of the owner of the 
copy of GIF Construction Set that wrote the file. If you're a registered user of the 
software, this will be your registration name and the company you work for, as 
entered when you installed Windows. If you're using an unregistered copy of GIF 
Construction Set, this will be your name and company as entered when you 
installed Windows, or a message stating that this information could not be found. 
Alternately, you can supply your own text for this block. See the discussion of 
Identification Text File.



Search for Paintbrush: If this item is enabled and Windows Paint – the 
MSPAINT.EXE file – is not found when GIF Construction Set boots up, the software 
will search your had drive for it. Disable this item if Windows Paint is not on your 
system. Note that if you have Windows Paint on your system, and GIF Construction 
Set has located it, this item will be ignored.



Identification Text File: You can configure GIF Construction Set to add a 
Comment block with your choice of text in it to every file you create. To do this, 
create your text in a plain ASCII text file using the Windows Notepad application. 
Save the file in your GIF Construction Set Professional parent directory. Having done
so, select this file using the Browse button of the Identification Text File field. Make 
sure the Identify Files option has been enabled.
The text file pointed to by Identification Text File must be plain ASCII text, not a 
word processor document. It can contain up to 16000 characters, although few 
users of your GIF files will thank you for including anything like this much comment 
text in them. Tabs will be replaced by single spaces.



JPEG Quality: This item defines the degree of detail loss used when exporting 
images to the JPEG format – this applies to functions such as the Button creator. 
Reduce this value to create smaller JPEG files, and increase it to make the graphics 
stored in them look more attractive.



Write Compressed AVI Files: Enable this item to have the GIF to Movie feature of
GIF Construction Set write compressed AVI files. Disable this item if you'll be 
creating AVI files to use with Visual BASIC, which can only accept uncompressed AVI
files as of this writing.



Write Directory Blocks: Enable this item to have GIF Construction Set preserve 
the titles of the image blocks in your GIF file in a Block Title. Block Title blocks are 
written after all the other blocks in a GIF file. They're is helpful in keeping track of 
the images in an animation sequence, for example. This item should be disabled if 
you're creating final GIF files for use on web pages, as Block Title blocks will 
increase the size of your GIF files.



Write Uncompressed GIF Files: Enable this item to have GIF Construction Set 
store all the images in the GIF files it creates uncompressed. Such files are legal GIF
files, and can be read by other GIF readers. However, they embody no LZW 
compression – they can also be read by LZW-free GIF readers. Note that 
uncompressed GIF files will typically be larger than their raw image data by a 
considerable margin. Unless you have a good reasons for doing otherwise, leave 
this item off.



Fast colour matching: If this switch is enabled, GIF Construction Set will use 
colour matching which is fast, but less accurate. Disable this switch for better 
dithering and closer colour matches.



AVI Quality Factor: The quality factor for writing AVI files should range from 100 
for unspeakably ugly to 10000 for almost perfect reproduction.



Registration Code: Your registration code is provided when you register GIF 
Construction Set. If you received GIF Construction Set on an Alchemy Mindworks 
CD-ROM, it's on your invoice in the line item for GIF Construction Set Professional. It
will look like this:

GIF Construction Set Pro REG # 12345-12-67890-88 $20.00

If you have received a confirmation e-mail message after registering GIF 
Construction Set, it will appear in this message, like this:

1 GIF Construction Set Pro REG CODE 12345-12-67890-88

GIF Construction Set Professional registration codes are all 17 characters long, in 
the form of one five-digit group of numbers, a dash, one two-digit group of 
numbers, a dash, a second five-digit group on numbers, a dash and a final two-digit
group of numbers. You must enter your code exactly in the Registration Code field 
to successfully register GIF Construction Set. The dashes separating the digit 
groups are not entered.

Note: Once it has been entered, your registration code will not be 
displayed by GIF Construction Set. If you have cause to re-install GIF 
Construction Set in the future, you will require your registration name and
code. Write them down now and store them in a safe place.

Registration Name: Your registration code is a complex checksum based on the 
characters of your name. If your name is not entered correctly in the Registration 
Name field, your registration code will not be accepted. Your registration name is 
printed on your invoice and is included in the confirmation e-mail message you 
received when you registered GIF Construction Set. It must be entered exactly – all 
the characters, spaces and punctuation in your registration name as it is provided 
to you must match what you enter in the Registration Name field.



No help is available for this item.



The Register Panel

Registration Code: Your registration code is provided when you register GIF 
Construction Set. If you received GIF Construction Set on an Alchemy 
Mindworks CD-ROM, it's on your invoice in the line item for GIF Construction 
Set Professional. It will look like this:

GIF Construction Set Pro REG # 12345-12-67890-88 $20.00

If you have received a confirmation e-mail message after registering GIF 
Construction Set, it will appear in this message, like this:

1 GIF Construction Set Pro REG CODE 12345-12-67890-88

GIF Construction Set Professional registration codes are all 17 characters long,
in the form of one five-digit group of numbers, a dash, one two-digit group of 
numbers, a dash, a second five-digit group on numbers, a dash and a final 
two-digit group of numbers. You must enter your code exactly in the 
Registration Code field to successfully register GIF Construction Set. The 
dashes separating the digit groups are not entered.

Note: Once it has been entered, your registration code will not be 
displayed by GIF Construction Set. If you have cause to re-install GIF 
Construction Set in the future, you will require your registration 
name and code. Write them down now and store them in a safe place.

Registration Name: Your registration code is a complex checksum based on 
the characters of your name. If your name is not entered correctly in the 
Registration Name field, your registration code will not be accepted. Your 
registration name is printed on your invoice and is included in the 
confirmation e-mail message you received when you registered GIF 
Construction Set. It must be entered exactly – all the characters, spaces and 
punctuation in your registration name as it is provided to you must match 
what you enter in the Registration Name field.



Reference

GIF Construction Set Professional embodies a great deal of functionality for 
managing and manipulating graphic images. It's unlikely that you'll find uses 
for absolutely everything GIF Construction Set knows how to do. It's more 
unlikely still that you'll want to try to learn everything there is to know about 
GIF Construction Set in a single session.

If you have not already done so, please read the Introduction and Tutorial 
document installed with GIF Construction Set. It will walk you through the 
basic operation of the software and provide you with step by step procedures 
for performing the most common tasks that GIF Construction Set is called 
upon to do.

          Animation wizard  
          Banners  
          Buttons  
          Comment block editor  
          Colour and Balance  
          Control block editor  
          Header block editor  
          Extract blocks  
          Flip and rotate  
          Image block editor  
          Image strip  
          Inserting images  
          LED Signs  
          Manage blocks  
          Movies  
          Overylay  
          Palette management selector  
          Plain text block editor  
          Protection Matrix  
          Reconstruct  
          Resize  
          Reverse  
          Supercompressor  
          Spin  
          System information  
          Transitions  
          Wide Palette GIF Files  



Header

You can edit the parameters of most of the blocks in a GIF file using GIF 
Construction Set Professional. The exception is a type of block called an 
Application block, something which has not been touched on thus far. 
Application blocks are what GIF files use to hold mysterious contents which 
only certain applications know how to work with. GIF Construction Set 
Professional will refuse edit these blocks.

To edit a block, double-click on it in the document window for its animation. 
The appropriate editor window will appear. 

If you double-click on the Header block for the BALL.GIF animation, you’ll see 
the Header block editor. There’s not all that much you’ll want to do to the 
Header blocks of animations as a rule. Here’s a quick overview of the controls 
and what they do.

Screen Width and Screen Depth: Every animated GIF file knows how big 
an area in pixels it should occupy. These values are automatically calculated 
by GIF Construction Set Professional as you construct a GIF file, and never 
need to be entered manually.

Background: This is the background colour used to display GIF files in GIF 
Construction Set Professional. It’s ignored by web browsers, but it’s handy to 
make sure your transparency is working properly, as discussed earlier. Click on
this button to select the background colour for the file in question.

Because the background colour is selected from the palette of your GIF file, 
this button also provides a convenient way to see what the whole palette 
looks like.
The number displayed by the Background button in the colour number of the 
background colour.

Palette: For the most part, you’ll want to leave the palette functions of the 
Header block editor alone for a while. One possible exception to this is the Edit
button, which will allow you to change specific colours in the palettes of your 
GIF files. It’s very important to keep in mind what editing colours actually 
means to a GIF file. If you change a colour in the palette of a GIF file, all the 
images in the file which use the colour in question will be affected.

Loop: If you enable the Loop switch in the Header block, your GIF animation 
will be created with a Loop block. The Iterations value defines the number of 
times your animation will loop. If you set this value to zero, it will loop 
indefinitely.



Insert

There are instances in which you might want to add blocks to a GIF file by 
hand. You can use GIF Construction Set Professional’s block insertion functions
to add still more images to an animation, and to add Comment and Plain Text 
blocks to a GIF file.

Note that Plain Text blocks are not supported by all web browsers, and should 
not be used if you’re creating GIF files for use on the web. When you see text 
in a GIF file, you’re really looking at a graphic which looks like characters.

If you click on any block in a document window, you’ll find that a blue or red 
line will appear along the bottom of the block. This is the insertion caret. Think
of it as having the same function as the flashing text cursor in a word 
processor. Whenever you insert a new block into a GIF file with GIF 
Construction Set Professional, the new block will appear after the block which 
currently has the insertion caret. The insertion caret will appear on the block 
you’ve most recently clicked on.

With the insertion caret currently positioned, you can insert a by:

Clicking on the green plus button in the tool bar 

or

Selecting Insert Block from the Edit menu

In either case, a menu will appear. Select the type of the new block to be 
inserted. 

If you insert a Comment or Plain Text block, a new block will be inserted 
immediately. You can subsequently double-click on the block in question to 
edit its contents.
A Comment block contains text which will not be visible when your GIF file is 
displayed. It can only be viewed with an application which looks for text in the 
block structure of a GIF file, such as GIF Construction Set or Graphic 
Workshop. Comment blocks are useful for including copyright statements and 
other background information about your GIF files.

Plain Text blocks include text which is displayed as part of your GIF file – but 
not by all web browsers. You can define the foreground and background 
colours of plain text, as well as assigning Control block attributes such as 
transparency. However, as Plain Text blocks are not useful on the web, you 
probably won't have much recourse to this feature of GIF Construction Set.

If you insert a new Image block, GIF Construction Set will prompt you for the 
name of one or more files to insert images from. You can select more than one
source image at a time. Each will be created as a new Image block and 
inserted after the insertion caret.

If the palette of your inserted images differ from that of the GIF file you're 
inserting them into, you'll see a Palette dialog. The Palette dialog will allow 
you to tell GIF Construction Set how to deal with the disparity in colour. Note 
that if your source images are in fact true-colour graphics, you'll always see 



the Palette dialog.

Here's what the Palette dialog options do:

Dither this Image to the Global Palette: If you select this option, your 
inserted image will be dithered to use the palette of your GIF file. This is the 
correct choice for photorealistic images.

Remap this Image to the Global Palette: If you select this option, your 
inserted image will be remapped to use the palette of your GIF file. This is the 
correct choice for line-art images.

Use a Local Palette for this Image: If you select this option, your inserted 
image will inserted into your GIF file using its own palette. While this will often 
produce much more attractive GIF files when they're displayed within GIF 
Construction Set, local-palette GIF files crash some web browsers and they 
can reach new heights of toenail-curling ugliness if they're displayed on 
machines having 256-colour Windows screen drivers. Don't use this option 
unless you have a convincing reason for doing so.

The Use this Selection for Subsequent Images option at the bottom of the 
Palette dialog will allow you to skip the Palette dialog for subsequent images if
you insert more than one image at a time. 

NOTE: While you can build a GIF file entirely by inserting Image blocks, this 
process does not allow you to create and match to a superpalette, as 
Animation Wizard does. Unless you've dealt with the palette considerations of 
your source images prior to inserting them into the GIF file you're building, 
you'll get better results with the Animation Wizard.



Palette

If the palette of your inserted images differ from that of the GIF file you're 
inserting them into, you'll see a Palette dialog. The Palette dialog will allow 
you to tell GIF Construction Set how to deal with the disparity in colour. Note 
that if your source images are in fact true-colour graphics, you'll always see 
the Palette dialog.

Here's what the Palette dialog options do:

Dither this Image to the Global Palette: If you select this option, your 
inserted image will be dithered to use the palette of your GIF file. This is the 
correct choice for photorealistic images.

Remap this Image to the Global Palette: If you select this option, your 
inserted image will be remapped to use the palette of your GIF file. This is the 
correct choice for line-art images.

Use a Local Palette for this Image: If you select this option, your inserted 
image will inserted into your GIF file using its own palette. While this will often 
produce much more attractive GIF files when they're displayed within GIF 
Construction Set, local-palette GIF files crash some web browsers and they 
can reach new heights of toenail-curling ugliness if they're displayed on 
machines having 256-colour Windows screen drivers. Don't use this option 
unless you have a convincing reason for doing so.

The Use this Selection for Subsequent Images option at the bottom of the 
Palette dialog will allow you to skip the Palette dialog for subsequent images if
you insert more than one image at a time. 



Image

Each frame of your GIF file is represented as an Image block. If you double 
click on an Image block in the document window for an animation, an Image 
block editor will appear. Seasoned users of GIF Construction Set will note that 
the Image block editor also includes a Control block editor bolted onto the 
side.

Image Width and Image Depth: This is the dimensions of the image in 
question in pixels. You can’t change these values per se, but if you resize the 
image, they’ll be adjusted by GIF Construction Set.
Image Left and Image Top: These are the number of pixels to move the 
image right and down from the upper left corner of the area the animation will
occupy, as defined in the Header block. You can set these manually - they can 
also be adjusted interactively through the Preview function, to be discussed in 
a moment.

Interlaced: By default, GIF images appear in your web page as you might 
expect - as each image is downloaded, it will be painted from the top down. If 
you enable the Interlaced option, they’ll appear in interlaced order, in a non-
linear sequence of lines. This makes it easier to see what a picture looks like 
before it has fully downloaded. It’s important to note that the Interlaced switch
is ignored by most web browsers for GIF files having more than one Image 
block.
Paint: The Paint button is unspeakably handy. Click on it, and the image 
associated with the Image block in question will open in Windows Paint. You 
can edit it in Paint. When you exit Paint, the modified image will be replaced in
your GIF file. If you change the dimensions of the image you’re working on in 
Paint, the Image Width and Image Depth values will change in the Image 
editor.

Palette: The Palette functions of the Image block editor are even more arcane
and potentially troublesome than those of the Header block. Ignore them.

Control: If you enable the Control Block option, the Image block in question 
will be preceded by a GIF Control block, and you’ll be able to apply 
transparency, delay and removal characteristics to it. Animations must have 
Control blocks for each image, or dire things may happen when they hit the 
web.

Transparent Colour: If you want to have an area of your image transparent, 
enable the Transparent Colour switch.

You can select the colour to be transparent either by clicking on the colour 
button below the Transparent Colour switch - typically pretty tricky - or by 
using the eyedropper tool to the right of the colour button, the preferred 
method. Click on the eyedropper tool and the image associated with the 
Image block being edited will appear. Click somewhere in the area to be made 
transparent.

If you create an animation with transparency, make sure you set the Remove 
By value correctly, as discussed below.



Delay: You can specify the time for which your image will be visible, as 
specified in 1/100ths of a second. While a delay value of zero is legal, it’s a 
really bad idea, as some web browsers behave erratically when they 
encounter it.

Remove By: The Remove By combo box will allow you to specify how your 
image should be dealt with once its delay time has expired and it’s time to 
move on to the next image in your GIF file. There are four Remove By options, 
but only two of them are supported by all web browsers. If you select Nothing,
your existing image will be painted over by the next image in your animation. 
If you select Background, your existing image will be painted over with the 
background colour or texture for your web page, and then the next image in 
your GIF file will be displayed. The latter is the correct choice for animations 
with transparency.

Do not select Leave As Is or Previous Image for GIF files to be used on the 
web.

Wait for User Input: This function is not supported by all web browsers. Do 
not select it for GIF files to be used on the web.

Preview: If you click on the Preview button, you’ll see your image displayed 
against the background colour defined in the Header block for your GIF file. 
You can click and drag in the image area to reposition it interactively. Click 
with your right mouse button somewhere in the Preview window to close it. 
Note that the Image Left and Image Top values in the Image editor window will
be changed if you move the image in the Preview window.



Comment

If you double click on a Comment block, a Comment block editor will appear. 
You can modify the text in a Comment block by editing the contents of this 
dialog.

The Format button changes the font used to display the text in GIF 
Construction Set Professional’s Comment editors. It does not affect how it will 
appear in other applications which might display your comment blocks.

GIF Construction Set Professional may append one or more comment blocks to
the GIF files it writes. While these are discussed in greater detail elsewhere in 
the documentation for the software, there are two specific Comment blocks 
you might want to keep in mind:

Unregistered Shareware: If you use an unregistered shareware copy of GIF 
Construction Set Professional to create a GIF file, a comment block to this 
effect will be added to the file. You can delete these within GIF Construction 
Set Professional’s document windows, but they’ll be replaced as soon as you 
save the file.

At such time as you register GIF Construction Set Professional, you can nuke 
the Unregistered Shareware comment blocks in GIF files you created by 
opening each one with your registered software, deleting the Unregistered 
Shareware Comment blocks and saving the files. Only a registered copy of GIF
Construction Set Professional can successfully delete an Unregistered 
Shareware Comment block.

Identify Files: By default, every file created by GIF Construction Set 
Professional will include a Comment block which identifies who created it. You 
can disable this feature entirely by switching off Identify Files in the GIF 
Construction Set Professional Setup dialog, or configure the software to use 
text of your own choosing. See the Reference document for more about the 
latter.



Plain Text
Plain text blocks consist of text and some information about how to display it. 
The text can be edited the same way comment block text is handled. The 
following fields define how plain text blocks will be displayed. Note: Plain 
Text blocks are not supported by all web browsers, and should not be
used if you're creating GIF files for a web page.

Text left and text top: These fields define where the text will appear on 
your screen, relative to the upper left corner of the viewing area. These values
are defined in pixels.

Grid wide and grid deep: These fields define a rectangle in which your text 
will be drawn. A grid ten wide and twelve deep would allow for twelve lines of 
up to ten characters each. Text which doesn't fit in the grid defined by a plain 
text block is not displayed.

Cell wide and cell deep: These fields define the dimensions of the 
characters used to display text. In theory, a GIF viewer should look at these 
fields and create a suitable monospaced font to display the text in question. In
most cases this is not so – GIF Construction Set included. Most GIF viewers will
use a font which is eight pixels wide and anywhere from eight to 32 pixels 
deep.

Foreground and background: These are the colours used to display the 
text in question. Note that if a plain text block is preceded by a control block 
which defines a transparent colour, one of these colours can become 
transparent. You can select these colours either by clicking on their colour 
buttons or by using the eyedropper tool to pick colours from the previous 
image block if one is present. The eyedropper tool will not be active if there is 
not at least one image block before the current plain text block.

Control: If you enable the Control Block option, the Plain Text block in 
question will be preceded by a GIF Control block, and you’ll be able to apply 
transparency, delay and removal characteristics to it.
Transparent Colour: If you want to have the background of your Plain Text 
block transparent, enable the Transparent Colour switch.
If you create an animation with transparency, make sure you set the Remove 
By value correctly, as discussed below.
Delay: You can specify the time for which your Plain Text block will be visible, 
as specified in 1/100ths of a second.
Remove By: The Remove By combo box will allow you to specify how your 
Plain Text block should be dealt with once its delay time has expired and it’s 
time to move on to the next block in your GIF file. There are four Remove By 
options, but only two of them are supported by all web browsers. If you select 
Nothing, your existing text will be painted over by the next image in your 
animation. If you select Background, your existing text will be painted over 
with the background colour or texture for your web page, and then the next 
block in your GIF file will be displayed. The latter is the correct choice for 
animations with transparency.



Do not select Leave As Is or Previous Image for GIF files to be used on the 
web.
Wait for User Input: This function is not supported by all web browsers. Do 
not select it for GIF files to be used on the web.

The Preview button will display the image preceding the plain text block being 
edited with the text in question superimposed over it. Hit Esc or click the right 
button of your mouse to exit the preview mode.



System Information

The System Information dialog will provide you with an overview of the 
configuration of your computer. This can be useful in unraveling configuration 
issues. It includes the following:

Screen Width and Screen Depth: These are the dimensions in pixels of 
your current screen display mode. 

Network Present: If this field is set to Yes, Windows is of the opinion that 
your computer is connected to a network of some sort.

Slow Machine: This field indicates Windows' assessment of the speed of your
computer.

Windows Version: This is the internal version number for your installation of 
Windows.

Machine Owner: This is the owner name used when you installed Windows.

Organization: This is the organization or company name used when you 
installed Windows.

Colour Depth: The last item in the System Information dialog indicates the 
number of colours which your current Windows screen driver can display 
without dithering. If this number is 256 or less, Graphic Workshop Professional 
is running a lot slower and looking a lot uglier than it needs to. See the Drivers
document for help in reconfiguring your Windows screen driver.



Manage

The Manage function in the GIF Construction Set Block menu will let you 
globally hange the Image and Control block attributes in your GIF files. It's 
useful for enabling lots of Control blocks at one time, disabling lots of Control 
blocks without wearing your mouse down to a puddle of molten plastic and for
changing the display characteristics of multiple images.

NOTE: This function only affects the selected blocks in the current document 
window. To apply it to all the blocks in a GIF file, click on the green "Tag All" 
button. You must click on the appropriate Apply buttons to enable the changes
made in this dialog.

Depending on the options you select, the Manage function's file selector will 
deal with Image or Control attributes. Specifically:

Enable Control Blocks: This option will enable the Control block attributes 
for each selected Image block.

Disable Control Blocks: This option will disable the Control block attributes 
for each selected Image block.

Set Control Blocks: This option will change the Control block attributes for 
each of the selected Image blocks with active Control blocks.

Image Block Position options: This section allows you to set the Left and 
Top fields of all the selected image blocks. If you enable the Absolute option, 
all the blocks will be set to the values specified. Otherwise, the left and top 
values will be incremented by the values specified, beginning with the left and
top values for the first selected block.



Control Blocks

Control: If you enable the Control Block option, the selected Image blocks will
be preceded by GIF Control blocks, and you’ll be able to apply transparency, 
delay and removal characteristics to them. Animations must have Control 
blocks for each image, or dire things may happen when they hit the web.

Transparent Colour: If you want to have an area of each selected image 
transparent, enable the Transparent Colour switch.

You can select the colour to be transparent either by clicking on the colour 
button below the Transparent Colour switch - typically pretty tricky - or by 
using the eyedropper tool to the right of the colour button, the preferred 
method. Click on the eyedropper tool and the image associated with the first 
selected Image block being edited will appear. Click somewhere in the area to 
be made transparent.

If you create an animation with transparency, make sure you set the Remove 
By value correctly, as discussed below.

Delay: You can specify the time for which each selected image will be visible, 
as specified in 1/100ths of a second. While a delay value of zero is legal, it’s a 
really bad idea, as some web browsers behave erratically when they 
encounter it.
Remove By: The Remove By combo box will allow you to specify how each 
selected image should be dealt with once its delay time has expired and it’s 
time to move on to the next image in your GIF file. There are four Remove By 
options, but only two of them are supported by all web browsers. If you select 
Nothing, your existing image will be painted over by the next image in your 
animation. If you select Background, your existing image will be painted over 
with the background colour or texture for your web page, and then the next 
image in your GIF file will be displayed. The latter is the correct choice for 
animations with transparency.
Do not select Leave As Is or Previous Image for GIF files to be used on the 
web.
Wait for User Input: This function is not supported by all web browsers. Do 
not select it for GIF files to be used on the web.



Extract

The Extract function in the GIF Construction Set Block will allow you to select 
one or more blocks in an existing GIF file and have them written out to a new 
GIF file.

If you select more than one Image block and enable the Numbered option, the
Extract function will create multiple numbered files, each with one image in it. 
The file names will consist of your destination file name with sequential 
numbers appended to it.

NOTE: This function only affects the selected blocks in the current document 
window. To apply it to all the blocks in a GIF file, click on the green "Tag All" 
button. You must click on the appropriate Apply buttons to enable the changes
made in this dialog.



Reverse

The Reverse function will reverse the order of the Image and Plain Text blocks 
in a GIF file. It does not affect the position of Comment and Application blocks,
which will retain their original order.



Reconstruct

The GIF Construction Set Supercompressor function – and several other GIF 
optimizers – reduce the size of GIF files by removing image information which 
is redundant from one block to the next. In effect, they prune away parts of 
your image frames which duplicate pixels in previous images. While this allows
for smaller files, it makes such supercompressed animations decidedly tricky 
to edit, resize or otherwise manipulate.

The Reconstruct feature will un-supercompress animations, restoring them to 
a sequence of complete frames of identical pixel dimensions. It will remove 
transparency and un-prune frames which have been reduced. The resulting 
animation will be effectively what the GIF Construction Set Animation Wizard 
would have created for you from an initial sequence of still frames.

In using Reconstruct, note that:

1. Your reconstructed GIF animation will appear identical to your source 
animation if you use the GIF Construction Set view function to see it in 
action. You'll probably notice changes in the pixel dimensions of some 
of the frames.

2. If you save a reconstructed GIF animation to disk, it will likely be a lot 
larger than the supercompressed animation it started out as.

Once you have modified a reconstructed animation, you can run it through the
Supercompressor function of GIF Construction Set to reduce its file size again.



Image Strip

The Image Strip function in the GIF Construction Set Block menu will export a 
multiple-image GIF file to a single image GIF file image strip. This will result in 
each of the images of your source GIF file being arranged one after the other 
in a long, narrow GIF file, much like the frames on a strip of movie film. 
When the size of an image strip is calculated, GIF Construction Set will allow a 
space equal to the largest frame in the source file for each image. In a file with
images of varying sizes, smaller images in the resultant image strip will be 
centered in a frame of the background colour of the file, as derived from the 
background colour of the source GIF file.

This feature is useful for creating Java applets which display images.
Here's what the options do:

Horizontal Strip: Creates an image strip in which the images are laid out 
horizontally.

Vertical Strip: Creates an image strip in which the images are laid out 
vertically.

Transparent Background: This will make the background colour of the 
image strip transparent. Use this feature carefully, as it might make some 
pixels in your images transparent too, if they happen to be the same as the 
background colour.

Descriptive Comment: This feature will add a comment block to your image 
strip GIF file which specifies the number of cells in the file and the dimensions 
of each cell.
NOTE: This function only affects the selected blocks in the current document 
window. To apply it to all the blocks in a GIF file, click on the green "Tag All" 
button. You must click on the appropriate Apply buttons to enable the changes
made in this dialog.
Because of the large image dimensions which usually result from creating 
Image strips, GIF Construction Set document windows which display them 
may run in Text Only mode, and not show you a preview image. This is normal,
and does not indicate a problem with your image strip.



Colour and Balance

The Colour and Balance function in the GIF Construction Set Block menu will 
allow you to fine-tune the colour, brightness and contrast of your GIF files. It 
applies to all the colours in all the images in a file – it always makes global 
changes to the colours of an animated graphic. The Preview button can be 
used to preview what you've done. The Reset button will return all the controls
to their default positions. In this position, the Colour and Balance function will 
have no visible effect on your graphics.



Animation Wizard

The Animation Wizard function of GIF Construction Set will build animated GIF 
files for you without troubling you unduly with the unpleasant internal details 
of GIF files. It can be accessed by selecting Animation Wizard from the GIF 
Construction Set File menu, or by clicking on the Animation Wizard magic 
wand button in the tool bar.

Animation Wizard will ask you a few things about how you want your 
animation to work and where the source images are, and it will then assemble 
your frames into a GIF file.

In creating an animation "from scratch," it’s best to think of yourself as the 
animation artist, and of GIF Construction Set Professional as the animation 
camera. It’s your responsibility to create the source images which will form 
the action in your animation. GIF Construction Set Professional will put them 
together into a completed animation for you. 

The Animation Wizard dialog works like a conventional Windows wizard - you 
can move back and forth through its screens by clicking on the Back and Next 
buttons. Each screen is set to a default value which will usually be correct.
For the curious, the fellow with excessive hair who seems to be looking for a 
lost contact lens at the left side of the Animation Wizard dialog is from a 
painting by William Blake entitled "Ancient of Days."

When the Animation Wizard dialog appears, click on Next to get started.
The first Animation Wizard screen will ask if you want to create a GIF file for 
use on a World Wide Web page. This actually gives Animation Wizard some 
guidance about how to choose a colour palette for your GIF file.

The second Animation Wizard screen will ask you if your want your GIF file to 
loop indefinitely or animate once and stop on the last frame. You can change 
this after you have built your animation if you like.
The third Animation Wizard screen will ask you how you want to handle the 
colour palette for your GIF file. This is easily Animation Wizard’s sneakiest trick
question. Here’s what these options mean:

Matched to Superpalette: If you select this option, Animation Wizard will 
look at all the colours in all the graphics in your animation and derive a 256-
colour palette which best reflects all your images. It will then remap all the 
colours in your source images to this palette. This option will usually give you 
the most attractive results.

Dithered to Superpalette: If you select this option, Animation Wizard will 
look at all the colours in all the graphics in your animation and derive a 256-
colour palette which best reflects all your images. It will then dither all the 
colours in your source images to this palette. This option is a good choice if 
you are building your animation from photorealistic images and you do not 
intend to add transparency to it.

Matched to First Palette: If you select this option, Animation Wizard will 
build your animation using the palette of the first image you select. This 



allows you somewhat more control over the final use of colours in your 
animation, but it can result in some truly wild colour shifts if the colours used 
by the first image in your animation are radically different from those in your 
subsequent images.
Photorealistic: If you select this option, Animation Wizard will dither your 
images to a palette with an even dispersal of colours from pure black to pure 
white. It selects a slightly different palette depending on whether you told it 
you wanted to create a graphic for use on the web or not. This option is a 
good choice for building an animation from source true-colour images, such as
JPEG files, wherein the source images all have widely varying colours. The 
results can look a bit grainy, but this is often the best that can be achieved 
with the limited colour facilities of a GIF file.
Drawn: This option uses the same palette as the Photorealistic option, but it 
remaps rather than dithers. This option is useful if you’re building animation 
from line-art source images.
Drawn in Sixteen Colours: This option behaves like the Drawn option, but it 
uses a palette with only the basic sixteen Windows colours. This is good for 
very simple animations with a restricted range of colours.

Unless you have a good reason to do otherwise, leave this screen set to 
Matched to Superpalette.

The fourth Animation Wizard screen will let you choose the delay between 
frames for your animation. This represents the time each image will appear 
before it’s replaced by the subsequent image in the sequence. For historical 
reasons - which no one can quite recall the history of any longer - GIF files 
represent delay times hundredths of a second. A setting of 100, then, 
represents one second. The delay times of individual images or of your entire 
animation can be changed after Animation Wizard has created your animation.
See the discussion of the Manage function elsewhere in this document.
The fifth Animation Wizard screen will let you select the source images for 
your animation. Click on the Select button to open a File Open dialog. You can 
select multiple source files at once. When you click on Open, the files you 
have selected will be added to the file list in Animation Wizard and the File 
Open dialog will appear again. Click on Cancel when you’re done selecting 
files. Note that you must select at least two source images to create an 
animation.
You can click and drag selections around the Animation Wizard list box.

The final screen of Animation Wizard will appear when you're ready to build 
your animation. Click on Done. Animation Wizard will load each of your source 
files and construct your animation. This may take a minute or two. It will 
display its progress in the status bar at the bottom of the GIF Construction Set 
Professional application window. When it’s done, it will open a document with 
your animation in it.

It’s likely that the animations you create with Animation Wizard will require 
some post-production fine tuning. You might want to add transparent 
elements, move some images around, make some images display for different
amounts of time and so on. Once an animation has been opened in a GIF 
Construction Set Professional document window - whether it got there through
the Open item of the File menu, the Animation Wizard or any of the other ways



to create animations yet to be discussed - it’s ready for you to work on using 
the many tools available in GIF Construction Set Professional



Supercompressor

In creating GIF animations for the web, it’s important to make the final GIF 
files that are referenced by your HTML documents as small as possible. The 
unspeakable, breathtaking excellence of your animations won’t impress 
anyone if they lapse into comas while waiting for your GIF files to download.

In some cases, it’s possible for sufficiently sneaky software to squeeze some 
unnecessary pixels out of your animations and in so doing create smaller GIF 
files. The sufficiently sneaky software is the supercompressor function in GIF 
Construction Set Professional.

It’s important to keep in mind what the supercompressor is really up to. All GIF
files are compressed. The supercompressor attempts to meddle with the 
blocks in your GIF files to make them more compressible. In some cases it can 
do quite a bit in this respect, and in others it’s wholly ineffective. If there’s 
nothing to squeeze out of your GIF file, the supercompressor will not make it 
any smaller.

The supercompressor makes GIF files smaller by doing one or more of the 
following to them:

Palette Compression: Just because your GIF file has a 256-colour palette 
doesn’t mean that all the colours in its palette actually appear in its images. 
The supercompressor surveys all the images in a GIF file and deletes those 
colours from the file’s palette which aren’t actually referenced by any of them.
If it finds enough unused colours, it will often be able to make the palette 
smaller, and hence recompress the file with a lower colour depth.

Prune Overlapping Frames: If an animation consists of multiple frames in 
which only the area in the middle of each frame actually contains action that 
changes, the supercompressor will prune away the edges of the frames and 
move what’s left down and to the right so it appears in the correct location.
Redundancy Compression: If an animation consists of multiple frames with 
a lot of identical areas, the supercompressor will replace the identical pixels 
with a transparent colour. Since all the replaced pixels will be one colour - the 
transparent colour - and areas of pixels that are all the same colour typically 
compress better than areas of pixels that are a variety of colours, the resulting
GIF file will get smaller.

Block Stripping: GIF files don’t need Comment, Plain Text or Application 
blocks to display themselves on your web page. The supercompressor can 
remove them for you.
The supercompressor will not change the way your animation appears, but it 
might well change what the individual frames look like. It’s a profoundly good 
idea to save your original source images under a different file name when you 
use the supercompressor. Once an animation has been supercompressed, it’s 
will often be very, very difficult to edit.

The supercompressor will not perform pruning or redundancy compression on 
GIF files which have one or more Image blocks with transparency enabled.

To use the supercompressor, open a GIF file in GIF Construction Set 



Professional and select Supercompressor from the File menu. Note that you 
can disable any compression types you don’t want to use, and the 
supercompressor will disable any compression types it decides are 
inappropriate for your GIF file. Click on Start to begin compressing. The OK 
button will be enabled when the supercompressor is done. When you click on 
OK, your supercompressed graphic will open in a new document window.

If the supercompressor can’t find anything to squeeze out of your GIF file, it 
will tell you so and the OK button will not be enabled.

NOTE: The supercompressor is good, but it’s not God. It can’t take a half-
megabyte bloated pig of a GIF file and Jenny Craig it down to ten kilobytes just
‘coz you really need a small file. Really huge complex animations typically 
require a rethink to get them down to manageable dimensions.



Flip and Rotate

The Flip and Rotate function in the GIF Construction Set Block menu will allow 
you to rotate some or all of the blocks in a GIF file in 90-degree increments, 
free-rotate them by any angle you like and flip them horizontally and 
vertically.
Note that free-rotating a bitmap will usually impose some rotation artifacts on 
it – you might find that your image is slightly degraded at some rotation 
angles. This will be a lot more apparent if you use dithered source images.
The Background colour button is used to define the colour of the revealed 
areas for free-rotated images.
NOTE: This function only affects the selected blocks in the current document 
window. To apply it to all the blocks in a GIF file, click on the green "Tag All" 
button. You must click on the appropriate Apply buttons to enable the changes
made in this dialog.



Resize

The Resize function in the GIF Construction Set Block menu will allow you to 
change the size of one or more images in a GIF file. You can resize images by 
size or factor – that is, you can resize them to specific pixel dimensions or you 
can resize them by a percentage. Note that resizing to a factor of 100 percent 
has no effect. Resizing to a factor of 50 percent will result in a graphic which is
half the size of the original. Resizing to a factor of 200 percent will result in a 
graphic which is twice the size of the original. 
In resizing down, the Resize function throws away some of the pixels in your 
source image. In resizing up, it duplicates some of the pixels. As such, resizing
always introduces some image degradation into your graphics. Use it carefully.

NOTE: This function only affects the selected blocks in the current document 
window. To apply it to all the blocks in a GIF file, click on the green "Tag All" 
button. You must click on the appropriate Apply buttons to enable the changes
made in this dialog.



Movies

GIF Construction Set will convert AVI digitized video files into animated GIF 
files, and animated GIF files to AVI files. It also includes an AVI preview 
function to help you check out your AVI files prior to converting them.

Converting AVI files to GIF files is relatively uncomplicated. There are, 
however, two possible catches to using this feature - GIF files so created can 
get very large, and may take a while to create. The latter will be especially 
true if your source AVI file has a lot of frames, or frames with relatively large 
pixel dimensions. Ten-megabyte AVI files aren't uncommon - ten megabyte GIF
files are not well regarded as adjuncts to web pages.

To convert an AVI file to GIF, select Convert Movie to GIF from the Movie item 
of the File menu of GIF Construction Set. Select a source AVI file. A dialog will 
appear to let you choose a colour management strategy for your GIF file. Here
are the choices and what they mean. The discussion of palettes elsewhere in 
this document will help you sort some of these out, if a quick read of them 
leaves you thinking that you should have studied remedial Martian in high 
school.
Dither to the 216-colour safe palette: This option will dither all the frames
in your movie to the 216-colour "safe" palette. This is technically the safest 
choice for movies which will be displayed in web pages - it will introduce some
dithering into your movies, but it will avoid radical colour shifts even on cheap 
computers from Sears.

Remap to the 216-colour safe palette: This option will remap all the 
frames in your movie to the 216-colour "safe" palette.

Dither to the 256-colour orthogonal palette: This option will dither all the
frames in your movie to the 256-colour orthogonal palette.

Remap to the 256-colour orthogonal palette: This option will remap all 
the frames in your movie to the 256-colour orthogonal palette.

Use source image palette: This option will make no attempt to adjust the 
source palette of the movie being converted, and it won't dither anything. This
will unquestionably produce the best-looking results for movies to be 
displayed on machines with 32,768-colour screen drivers or better. Machines 
with 256-colour drivers will probably introduce some colour shifts into movies 
converted with this option. Life's a bitch this way. This option is also vastly 
quicker than the previous four, as it doesn't have to process each frame of the
source image. You can't use this option with 24-bit source movies.

Dither to Superpalette: This option will survey all the frames in your source 
AVI file and create a palette which best reflects their use of colour. All your 
source frames will be dithered to this palette. This option will typically produce
the best results for photorealistic source AVI files.

Remap to Superpalette: This option will survey all the frames in your 
source AVI file and create a palette which best reflects their use of colour. All 
your source frames will be remapped to this palette. This option will typically 
produce the best results for line-art source AVI files.



Plan to experiment with this to get the best results. Keep in mind that 
squeezing a true-colour movie into a 256-colour GIF file will always introduce 
some image degradation into the images therein.

You can convert animated GIF files to AVI files through the GIF to Movie option 
of the Movie item of the File menu. For the most part, this will be a fairly 
transparent process - there are a few things to keep in mind, however.
You cannot convert GIF files having local palettes for some or all of their 
images to AVI files.
Each frame in an AVI file must appear for the same length of time. GIF 
Construction Set will set the frame delay time for AVI files at the longest delay 
time of all the frames in your source GIF file.

Plain Text blocks are ignored by the GIF to AVI converter.
You must have at least two Image blocks in your source GIF file to convert to 
AVI.

Compressed AVI files are lossy – they sacrifice some detail for better file 
compression. You can adjust the amount of detail loss in an AVI file being 
written by GIF Construction Set by setting the AVI Quality Factor value in the 
Setup dialog. The quality factor can range from 10 to 10000, where 10000 will 
leave you with almost perfect reproduction and truly enormous AVI files. You 
can also turn off AVI compression entirely by disabling the Write Compressed 
AVI Files option in Setup.This is useful if you'll be creating AVI files to use with 
Visual BASIC, which can only accept uncompressed AVI files as of this writing.

If you convert a very small GIF file to AVI, it may not play properly in some 
applications as its window will be stretched to allow for a title bar, minimize 
and maximize buttons and so on. There's nothing actually wrong with the file -
this is just how some AVI players handle tiny files.

Loop blocks are ignored by AVI files - you can't specify looping in an AVI movie.

Dithered images converted to AVI files will typically lose some quality – set the
AVI Quality Factor set to a high value to minimize this.

Converting GIF files to AVI movies will almost always result in AVI files which 
are several times the size of the source GIF files from whence they have come.

NOTE: The AVI files created by GIF Construction Set are written by a library 
included with Windows, called a "codec." As it's shipped, Windows writes fairly
conventional, widely accepted AVI files. Some applications replace the 
standard Windows AVI codec with a non-standard codec when they're 
installed. If the AVI files being created by GIF Construction Set don't get along 
with the applications you import them into, either your target application is 
looking for non-standard AVI files, or your codec is creating them.
The Preview Movie function of the Movie item of the File menu will let you see 
what an AVI movie looks like before you convert it to GIF, and check the 
results of converting to AVI files. It uses the standard Windows AVI functions to
play AVI movies.



LED Signs

The LED Sign function in the GIF Construction Set Edit menu will allow you to 
create scrolling banners which resemble the LED signs found in subways, 
video stores, airports and many up-market churches. You can program GIF 
Construction Set's signs for colour changes, adjustable playback speed and 
varying sign dimensions.

The text for an LED sign is displayed in white LEDs by default. Technical sorts 
will observe that there's no such thing as white LEDs – we would note that this
is only true in the real world, with which GIF Construction Set's LED signs have
as little contact as possible. You can change the display colour at any point in 
the text by embedding a colour code. Colour codes consist of the @ sign 
followed by a letter. Here are the legal colour codes:
@R – red 
@G – green 
@B – blue 
@C – cyan 
@M – magenta 
@Y – yellow 
@W – white 
Here's some example coded text:
This text is @Rred, @Ggreen, @Bblue, @Ccyan, @Mmagenta, @Yyellow, @Wand white.

This is what the colours would appear as in the LED sign function:

You can include as many colour changes as you like in a sign, as long as the total text length
including the colour codes is no greater than 260 characters.
LED signs can generate a large number of individual images, and hence potentially large GIF
files. Mitigating this to some extent is the nature of the individual images in a sign. They're 
sixteen-colour graphics, and use simple, predictable shapes that compress well. As such, it's 
possible to create fairly complex signs without necessarily making them unworkably long to 
download. Note the observations about file size below.

Here's what the controls in the LED Sign function do:
Loop: If this item is enabled, the sign will continually repeat itself. If it is not 
enabled, this sign will cycle once and go dark.
Show Dark Pixels: If this item is enabled, LEDs that are not lit up will be 
displayed as dark grey. Note that this will typically increase the file size of a 
GIF file containing an LED sign – you will probably want to leave this one 
disabled.

Smooth Scroll and Columns per Frame: If the Smooth Scroll option is 
enabled, the sign text will scroll smoothly, moving by the number of pixels 
defined in the Columns per Frame control. This should be set to one for the 
smoothest scrolling. If Smooth Scroll is disabled, the sign text will scroll by the 
width of one character per frame. This is arguably less attractive, but it will 
typically create signs with far fewer images, and as such much smaller file 
sizes. If you do create signs with smooth scrolling enabled and you need to 
reduce the final file size, try increasing the Columns per Frame value slightly. 
This will result in somewhat less smooth scrolling, but will reduce the number 



of images involved in displaying a complete sign quite a lot.

Compact Sign: If this item is enabled, GIF Construction Set will create small 
signs. If it's disabled, it will create large signs. Large signs look slick, but they 
result in much larger files.
Columns Wide: This field sets the number of vertical columns of LEDs in the 
sign to be created. Large values will result in wider signs, capable of 
displaying more text at once, but also in larger final files.

Delay: This field sets the delay in 1/100ths of a second between images. 
Increase this value to slow down the scrolling of an LED sign. Note that if you 
adjust the Smooth Scroll or Columns per Frame items in the LED Sign dialog, 
you'll probably have to change this value as well.

Palette Compression: If this option is enabled, your GIF file will be stored 
with the least possible colour depth.

The text in a sign can consist of any printable ASCII characters between ASCII 
32, a space, and ASCII 126, a tilde. Any other characters will be displayed as a
double dagger symbol.



Wide Palette GIF Files

The Wide Palette GIF function in GIF Construction Set's Edit menu will let you 
create GIF files which can display more than 256 colours. This probably sounds
much more useful than it really is – while it genuinely works, it embodies some
serious catches. Before you use this feature, please take a moment to 
understand what it's up to so you don't wind up bashing your head against a 
wall in frustration.

Alchemy Mindworks will not be responsible for any damage you do to your 
head or your walls should you fail to heed this advice.

A GIF image can only store a maximum of 256 colours. However, a GIF file can
store any number of images. If each image has its own local palette, it's 
possible to have more than 256 different colours stored in the file.
This is what wide palette GIF files do. If the source image you wish to store in 
one has 510 distinct colours, GIF Construction Set will create a GIF file with 
two Image blocks. The first Image block will have a local palette with the first 
255 colours of your source image in it. The second Image block will have a 
local palette with the second 255 colours from your source image. Each 
palette will also have one colour which does not appear anywhere in your 
source image, to be used as a transparent colour.

In discussing wide palette GIF files, the Image blocks that your source image 
will be split into are called "panes".

The actual images will be constructed such that those pixels of your source 
image which appeared in their palettes will appear in the images in question, 
and the transparent colour will appear everywhere else.
When such a GIF file is displayed, the first Image block will take care of the 
first 255 colours, and the second Image block will take care of the second 255 
colours. Because the "unused" pixels are transparent, the two frames will 
essentially be merged when the display is completely updated, with the result 
that 510 distinct colours will be displayed.

In practical terms, a 24-bit source image must be "quantized" to derive a 
suitable list of colours, that is, a large palette must be derived from it based 
on the dispersal of source colours. The Wide Palette GIF function lets you 
select how large this palette can get.

Wide palette GIF files allow you to enjoy lossless images having lots of colours 
in a format which is compatible with existing web browsers. However, they 
embody some important catches, as follows:
Wide palette GIF files tend to get large, as they require that a single 24-bit 
image be split into multiple 256-colour images, each of which must be stored 
separately.

While Netscape, Internet Explorer, Graphic Workshop and GIF Construction Set
will display wide palette GIF files correctly, almost nothing else will. This 
includes most GIF viewers and paint packages.
If a wide palette GIF file is displayed on a system running with a 256-colour 



screen driver, it will look really awful.

Wide palette GIF files cannot include transparency, as they use transparent 
colours for their own purposes. They could in theory be animated, if you 
wanted to push the envelope, but the results would be very, very slow and 
quite ugly.

Here's what the controls in the Wide Palette GIF dialog do:
Maximum number of colours: This sets the maximum possible wide palette
size. If your image turns out to have fewer distinct colours than this, the 
palette may get smaller. As each pane in a wide palette GIF file can hold a 
maximum of 255 colours – plus one transparent colour – this also defines the 
maximum number of panes.
Interlace: If this option is enabled, the pane images of your wide palette GIF 
file will be written interlaced. This looks really slick in GIF Construction Set, but
it will typically have no effect in a web browser, which do not display 
interlaced images as interlaced when they occur in multiple image GIF files.
Add Initial Sketch Image: If this option is enabled, the panes of your wide 
palette GIF file will be preceded by a fairly coarse sixteen-colour version of the
image, which will eventually be wholly overwritten by the following panes. It's 
something to look at in the mean time, however. Turn this feature off if you 
want to create slightly smaller GIF files. The sketch image ignores the 
Interlace option, and is always non-interlaced.
Fifteen-bit Quantize: This option will allow the wide palette GIF function to 
choose a better wide colour palette. It takes a lot longer to complete its work, 
however.

Wide Palette Dither: This option allows the wide palette GIF function to 
dither its images, minimizing the banding effects of colour remapping. 
Dithering with several thousand colours looks really sharp.
Select: Use this button to load a source image. Source images must be stored
as 24-bit files – that is, as true-colour BMP, JPG, TGA, PCX and PNG files, and 
other suitable formats. You cannot use a GIF file as the source for the Wide 
Palette GIF function.

Sorted Palette: If this option is enabled, the wide palette created by the 
Wide Palette GIF function will be sorted, such that the brightest colours appear
first, and turn up in the first panes. If it's not enabled, the palette colours will 
appear randomly. This won't affect how your wide palette GIF images look 
when they're finally displayed, but it does affect what they look like as they're 
being built up on your screen. This is especially true if you enable the 
Interlaced switch. 
Test: This function will test a wide palette GIF image. Considering the time it 
takes to create one of these things, you might want to skip the Test function.

By default, the background colour of a wide palette GIF file will be white – you 
can change this by editing its Header block. This doesn't matter to a web 
browser, which ignores the background colour values in GIF files.
Select the maximum colour size carefully. More colours will produce much 
better looking final images, but they'll also create much larger final GIF files.





Spin

The Spin function in the Edit menu will rotate an existing image in two 
dimensions. It can be used to create animated GIF animations which look like 
a spinning wheel or other revolving object seen face-on.

NOTE: The Spin function only rotates in two dimensions. Think of a 
phonograph record, or if you're too young to have seen one outside a 
museum, think of a CD-ROM viewed from above. This is distinct from rotation 
in three dimensions, which requires a three-dimensional modeling package, 
ray tracing and several hours of rendering time. GIF Construction Set can do 
the former – it cannot do the latter, nor is it likely to any time soon. If you 
contact us about how to do three-dimensional rotation using the Spin function,
we will with the greatest regret be forced to dispatch the oft-mentioned 
leather-winged demon of the night to do something unspeakably nasty to you.

Here's what the Spin dialog's controls do:
Select: Before you can use the Spin function, you must decide what you want
to spin. The Select button will allow you to select a source image file. Source 
images scan be drawn from any of the supported file types listed elsewhere in 
this document. Note that if you select a multiple-image GIF file as your source 
image, only the first image in the file will be used.

Direction: You can specify clockwise or counterclockwise rotation.
Steps: The Steps value determines the number of degrees each image in 
your final file will be rotated, and as such, the number of frames in your final 
GIF file. This can range from 2 to 360. More steps will result in smoother 
animation, but with larger final files and slower movement.
Delay: The Delay option sets the number of 100ths of a second between cells 
for a spin effect.
Loop: The Loop option determines whether the spin effect will repeat 
indefinitely or only rotate once.
Transparent Background: The Transparent Background option sets the 
background colour to be transparent for the spin effect you're creating.
Remap to Default Palette: The Remap to Default Palette option will cause 
your source image to be adjusted to use the currently selected default palette,
as configured in the Setup dialog.

Background: The Background colour button sets the background to be used 
in creating spin effects.

Test: The Test button will let you preview your graphic.
Destination Rectangle: These controls determine the size of the area in 
which your graphic will rotate. The Maximum option will create a final GIF file 
which is big enough to include all the rotated parts of your source image. The 
Minimum option will create a final GIF file which only encompasses the area 
that's common to all the rotated frames. The Original option will create a final 
GIF file which has the same dimensions as your source image. 



Palette Compression: If the palette compression option is enabled, your GIF 
file will be stored with the least possible colour depth.

Note that rotating a bitmap will usually impose some rotation artifacts on it – 
you might find that your image is slightly degraded at some rotation angles. 
This will be a lot more apparent if you use dithered source images.



Banners

The Banners function in the Edit menu of GIF Construction Set creates 
sophisticated text banners, which can be either still or animated. If you’re 
interested in creating complex banner advertisements, have at look at the 
Build Banner Ads that Rock article at our web page, 
http://www.mindworkshop.com/alchemy/banners/banners.html.

To create a banner, select the Banner item from the Edit menu of GIF 
Construction Set Professional. The Banner dialog will appear.

The tabs at the top of the Banner dialog select the type of special effects to be
added to your text. These are:

Simple: Your text will be drawn in a solid colour, with or without a drop 
shadow.

Embossed: Your text will be drawn with highlight and shadow lines to make it
appear to rise from the surface of your monitor.

Teletype: Your text will be drawn one character at a time, in a solid colour, 
with or without a drop shadow.

Glow: Your text will be drawn against a black background with a simulated 
glow and optional neon tubes.

Soft shadow: Your text will be drawn in a solid colour with a soft shadow 
behind it.

Texture: Your text will be cut from a tiled texture and drawn with an optional 
drop shadow.

Scanners: Your text will be drawn in a solid colour, with or without a drop 
shadow, with a bright scan line animated over it.

Waves: Your text will be drawn a moving wave between the Crest and Trough 
colours.

With the exception of Teletype and Scanners, all the Banner effects can be 
used either to create single lines of still text or to create text that rolls in from 
the right. The Teletype and Scanners effects are always animated.

There are a number of parameters to adjust for each of the banner effects. 
Here’s what they do. Note that not all these parameters are applicable to all 
the effects - they won’t appear on the tabs where they’re not needed.

Background colour: The colour of the area behind your text and its shadow.

Backscatter colour: The colour of the glow to the right and left of the scan 
line in the Scanners effect.

Crest colour: The colour of the wave crests in the Wave effect.

Glow colour: The backlight colour for the Glow effect.



Outline colour: The colour used to outline the text in Textures effect.

Scan colour: The colour of the scan line in the Scanners effect.

Shadow colour: The colour the drop shadow behind your text will be drawn 
in.

Text colour: The colour your text will be drawn in.

Trough colour: The colour of the wave troughs in the Wave effect.

Tube colour: The colour for the neon tubes in the Glow effect, if they’re 
enabled.

Note that as with all the colour buttons in GIF Construction Set Professional, 
you can change any of the foregoing by clicking on the button in question and 
selecting a new colour.

Anti-alias: If this item is enabled, your text banners will be created with anti-
aliased text, which will help reduce the jagged appearance of diagonal edges 
of characters. See the Reference document for a more detailed discussion of 
this feature.

Banner Text: This is the text to be used to create your banner. Banner text 
can occupy up to 260 characters.

Cells: This is the number of individual images that will be created for your 
animated text banner. More cells will result in smoother animation, but also in 
larger files. In some cases, this value is more of a suggestion than an absolute
number, and GIF Construction Set Professional might decide to create an 
animation with one or two more or fewer images.

Compress Palette: If this item is enabled, GIF Construction Set Professional 
will supercompress the palette for your text banner once it has been created, 
possibly creating a smaller final GIF file. This will increase the time it takes to 
complete a banner - you might want to leave it disabled if you’re just 
experimenting.

Delay: This is the number of 1/100ths of a second that each image in your 
animation will appear for. Increase this number to slow your animation down.

Dither: Enable this item to have the colours in the textures used by the 
Texture effect dithered to the palette of the banner being created. Disable it to
have them remapped.

Drop shadow: Enable this item to show a drop shadow behind your text.

Extra Soft: Enable this item to increase the softness of the soft shadows in 
the Banner function.

Font: Click on this button to select the typeface, size and effect for the text 
you’d like to create. GIF Construction Set Professional will create text banners 
using any alphabetic font in your system. Note that it will not work with 
symbol fonts or with most two-byte fonts, such as Kanji, Arabic or Hebrew.



Frequency: Sets the frequency of the crests in the Wave effect.

Leading edge: Disable this item to remove the text to the right of the scan 
bar in the Scanners effect.

Neon and Glow: These items select which of the Glow effects GIF 
Construction Set Professional will create.

Offset: This is the offset in pixels between your text and its drop shadow.

Outline: Enable this item to have your texture banners drawn with an outline.

Palette: This is the palette to be used to create your banner.

Pause: This is the delay for the last frame in your animation, right before it 
loops. It can be used to build in a pause before the banner begins to appear 
again.

Radiance: This tells the Glow effect how bright to make the blow behind the 
text it draws. Very high radiance values can produce really strange banners.

Rolling: Enable this item to create an animated text banner, and disable it to 
create a single image of the text you’re entered.

Texture: Click on this button to select the texture to be used by the Texture 
effect. You can add your own textures to the Texture effect. The Reference 
document includes a more compete discussion of textures.

Transparent: Enable this item to make the background colour of your text 
banner transparent. Note that this can be changed after your banner is 
created by editing the Image blocks for its individual frames.

Wide Bar: Enable this item to increase the width of the scan line created by 
the Scanners effect.

You’ll probably want to experiment with the Banner function at length to really
get a feel for what it’s capable of. When you’ve entered some text, chosen a 
banner type and set up its parameters, click on Test to see how your banner 
will look as an animated GIF file. 



Buttons

The Buttons function in the Edit menu of GIF Construction Set creates beveled 
button graphics. It can generate these both as GIF files, which will open in GIF 
Construction Set document windows, and as 24-bit JPG, PNG, PCX, BMP and 
TGA files through its Export function.

GIF Construction Set's buttons can be of any colour you like, using any font in 
your system.

You can create buttons with either round or square corners. GIF Construction 
Set will create suitable dark and light colours to simulate the three-
dimensional contours of the buttons you specify.

Here's what the Button controls do:

Text Colour: This is the colour of the text to be used to create your button.

Button Colour: This is the colour of your button. The button creator will 
generate both lighter and darker colours based on this colour. As a rule, fairly 
dark colours will create more convincing buttons.

Background Colour: This is the colour of the background upon which your 
button will be drawn. This has no effect on rectangular buttons – it will be used
to draw the areas outside the rounded corners of round buttons. If you enable 
the Transparent option, make sure you choose a background colour that's 
markedly different from the button or text colours you've selected to avoid 
having transparent areas show up unexpectedly within your buttons.

Font: This is the font to be used to draw the text in your buttons. You can 
select any font installed in your system.

Drop Shadow: Enable this item to have your text drawn with a drop shadow. 
The drop shadow will be drawn to the right and below your text by the number
of pixels specified in the offset control, in a colour which is somewhat darker 
than your text. See below for a discussion of derivative colours.

Highlight: Enable this item to have your text drawn with a highlight. The 
highlight will be drawn to the left and above your text by the number of pixels 
specified in the offset control, in a colour which is somewhat lighter than your 
text. See below for a discussion of derivative colours.

Anti-alias: If this item is enabled, your buttons will be created with anti-
aliased text, which will help reduce the jagged appearance of the diagonal 
edges of characters. Because of the palette limitations of buttons written to 
the GIF format, anti-aliasing may have less effect on the appearance of the 
text in buttons that it does in other functions of GIF Construction Set. It's more
applicable to buttons exported to other formats, such as JPG. See below for a 
discussion of exporting buttons.

Round: Enable this item to create round-corner buttons. Disable it to create 
square-corner buttons. Art-college alumni, industrial graphic designers and 
people who paste up beer advertisements for a living will want to leave this 



item disabled.

Transparent: Enable this item to make the areas outside the round corners of
a round-corner button transparent. See discussion of transparent background 
colours above. Note that as none of the 24-bit formats to which buttons can 
be exported support transparency in any useful way, the setting of this option 
will be ignored by the Export function.

Depth: This is the depth in pixels of the bevel for your button.

Padding: This is the space in pixels between the inner edge of the bevel and 
the text of your button.

Offset: This is the distance in pixels between your text and its highlight and 
drop shadow images, assuming you have either Drop Shadow or Highlight 
enabled. GIF Construction Set will not allow you to use an Offset value that's 
larger than the current Padding value.

Export: GIF files support a maximum of 256 colours, and while this is capable 
of creating pretty convincing buttons, it doesn't really allow for anti-aliasing. If 
you click on the Export button, you can export your button as a 24-bit image 
to any of the secondary file formats supported by GIF Construction Set 
Professional, to wit, JPG, BMP, TGA, PCX and PNG. It's most likely that you'll 
want to use JPG if you're creating buttons for a web page. You may need to 
configure the JPEG Quality Factor in the Setup dialog prior to doing this. See 
the discussion of JPEG files in the Graphics Tutorial for more about how all this 
works.

A few words about derivative colours: To begin with, you need not read 
this next bit, and you might be happier if you didn't. Should you do so despite 
this warning and find that your head hurts, be comforted in knowing that the 
discomfort will pass as soon as you turn off your computer.

In creating buttons, GIF Construction Set will create four new colours to draw 
with based on the Button Colour and Text Colour values you have specified. 
The four new colours are called Bright, Dark, Text Shadow and Text Highlight. 
They're defined as:

Bright = Button Colour * 1.25
Dark = Button Colour * 0.60
Text Shadow = Text Colour * 0.50
Text Highlight = Text Colour * 2.00

That is, the Bright colour is 25 percent brighter than the Button Colour, the 
Dark colour is 60 percent as bright as the Button Colour and so on. The 
highlighted areas of a button are drawn in the Bright colour and the shaded 
areas in the Dark colour.

If you find that you don't like these derivative colour values, you can change 
them. To do so, you must edit the file \WINDOWS\GCSPRO.INI. Use Windows 
Notepad to open this file, and be sure GIF Construction Set is not running 
when you do so. Locate the following four lines:

ButtonDarkFactor = 60
ButtonBrightFactor = 125



ButtonTextHighFactor = 200
ButtonTextShadowFactor = 50

These numbers represent the percentage of brightness for each of the four 
derivative colours, multiplied by 100. As such, the factor by which the Button 
Colour is multiplied to derive the Bright colour, 1.25, is represented here as 
125.

You can experiment with these values – if you choose radically nonsensical 
values, GIF Construction Set may draw some very strange buttons indeed.



Transitions

The Transitions function in the Edit menu will create animated transitions 
between multiple still images. These can range from simple wipes and 
dissolves to complex special effects.

You can add as many images as you like to the Transition function and have it 
create a final animated GIF file which contains all the frames of the effects 
you've chosen.
To create a transition, select Transitions from the Edit menu of GIF 
Construction Set. Click on the Add button. A File Open dialog will appear to 
select source image files. You can build a transition from any combination of 
the file types GIF Construction Set recognizes, including GIF, JPG and BMP.
Once you have added the source images for your transition, select a default 
transition. Here's what the transition types do:
Blocks: Your images will dissolve in a sequence of blocks which increase in 
size.
Dissolve: Your images will fade from one graphic to the next.

Interlace: Your images will dissolve in a complex interlace of pixels.
None: Your images will transition from one graphic to the with no animation. 
This is a quick way to make slide shows.
Radar: Your images will transition from one graphic to the next in a pie-
shaped segment that gradually expands.
Raster: Your images will transition from one graphic to the next as a 
sequence of bars. There are horizontal and vertical rasters available.

Roll: Your images will transition from one graphic to the next by rolling one 
image above the previous one. This looks like paper emerging from a 
photocopier.

Sandstorm: Your images will transition from one graphic to the next in a 
random scattering of pixels.

Spinners: Your images will appear to rotate on a moving sign. There are four 
spinner options, one for each direction.

Split: Your images will transition from one graphic to the next by splitting into 
two. There are horizontal and vertical splits available.

Tile: Your images will transition from one graphic to the next in a random 
scattering of square tiles.

Wipe: Your images will transition from one graphic to the next by wiping. 
There are four wipe options, one from each direction.

There are several other controls in the Transitions dialog:
Delay: This defines the number of hundredths of a second between images in 



your transition. Increase this value to slow your animation down.

Pause: This defines the delay for images between transitions. It should 
typically be somewhat longer than Delay.

Dither: Enable this item to have your transition images dithered to the 
selected palette. Disable this item to have them remapped. Dithering will 
provide somewhat better colour management, especially for photorealistic 
subjects, at the cost of some image resolution.

Custom Palette: Enable this item to have a superpalette created for your 
transition. Disable it to use the selected palette for your final animated 
transition.
Anti-alias: Enable this item to have your transition images anti-aliased. See 
the discussion of anti-aliasing elsewhere in this document for more about this 
feature.

Palette: This defines the default palette from which the matt colour for your 
transition will be drawn, and to which it will be dithered or remapped if you 
don't enable Custom Palette. Note that while this palette selector supports 
palettes with fewer than 216 colours, some of the transition effects will look 
very strange indeed if you use them.
Matt Colour: All the frames in a transition must have the same dimensions in
pixels. If you attempt to create a transition with source images of various 
dimensions, your final transition will have the dimensions of the largest of 
your source images, with the smaller images insert into a matt of a colour 
defined by this item.

Advanced: The Advanced button will provide you with access to a number of 
controls to fine-tune parameters of the Transitions dialog. It's a good idea not 
to mess with these unless you understand what they're up to.

Sandstorm Block Size: This is the number of points that will be painted 
per frame for the Sandstorm transition. Increasing this value will create 
fewer frames, but with coarser action.

Horizontal Step: This is how far transitions which move horizontally will 
shift in one frame. This affects effects like Horizontal Wipe and Horizontal 
Raster.
Vertical Step: This is how far transitions which move horizontally will shift
in one frame. This affects effects like Vertical Wipe and Vertical Raster.
Block Spacing: This is the distance in pixels between the expanding tiles 
in the Blocks transition.
Raster Size: This is the thickness in pixels of the lines in the Raster 
transitions.
Tile Size: This is the size in pixels of the tiles in the Tile transition.

Tile Block Size: This is the number of tiles that will be painted per frame 
for the Tile transition. Increasing this value will create fewer frames, but 
with coarser action.
Dissolve Step Size: This is the amount of blending per frame in the 



Dissolve transition. Increasing this value will produce dissolves with fewer 
steps but with coarser action.
Radar Start Angle: This is the angle at which the Radar effect begins, in 
degrees.
Radar Step Angle: This is the amount by which the Radar effect moves 
per frame, in degrees.



Registering GIF Construction Set Professional

GIF Construction Set Professional and all its ancillary applications
are shareware. We invite you to evaluate the GIF Construction 
Set Professional package to see if it's suitable for your needs. If 
you like it, please register it. If it turns out not to be what you 
need, or if you don't feel it's worth registering, please delete it 
from your hard drive and accept our thanks for trying it out. If 
you do productive work of any sort with this software, you are no
longer evaluating it.

If you like GIF Construction Set Professional and you find it useful, you are 
requested to register it. The current registration fee is $20.00 – plus $5.00 
shipping if you'd like the latest version sent to you on CD-ROM. This will entitle
you to technical support, notification of updates, a free copy of the latest 
version of this software and other worthwhile things. It will also avail you of a 
registration number to shut off the closing beg notice. More to the point, 
though, it'll make you feel good. We've not infested GIF Construction Set with 
excessive beg notices, crippled it or had it verbally insult you after ten days. 
We trust you to support this software if you like it.

When you register GIF Construction Set, you will be e-mailed your registration 
code as soon as your order is processed. Enter your code into a downloaded 
copy of GIF Construction Set and it will become a registered copy, identical to 
what you would receive on CD-ROM. If you want to save the $5.00 shipping 
fee, select the NO SHIPPING option when you order. Note that absolutely 
nothing is shipped for NO SHIPPING orders – not even a receipt.

If you want to see additional features in GIF Construction Set, register it. If we 
had an Arcturian mega-dollar for everyone who has said they'd most certainly 
register their copy if we'd add just one more thing to it, we could buy 
ourselves a universe and retire.

Oh yes – should you fail to support this program and continue to use 
it, a leather winged demon of the night will tear itself, shrieking 
blood and fury, from the endless caverns of the nether world, hurl 
itself into the darkness with a thirst for blood on its slavering fangs 
and search the very threads of time for the throbbing of your 
heartbeat. Just thought you'd want to know that.

Order On Line

You can order on line at our web page 
http://www.mindworkshop.com/alchemy/alchemy.html – click on any of the blue key 
icons to access the secure server.



Order by Phone

Call our toll-free order desk at 1-800-263-1138 from Canada and the 
United States. Call 0800-89-7355 from Great Britain. Call 1-800-554-082 
from Australia. Callers from other countries can reach the order desk at 1-
905-936-9500. The order desk is available 24 hours a day, seven days a 
week.

Please note: the order desk only takes credit card orders. They 
cannot provide you with order status, modify or cancel previously 
submitted orders, provide product information or help you out with 
technical support. They cannot transfer you to someone who can.

Order by FAX

You can FAX your order to 1-905-936-9502. Please use the order form 
included with this software. 

Order by Snail-Mail

You can mail your order to:

Alchemy Mindworks Inc.
P.O. Box 500
Beeton, Ontario
L0G 1A0
CANADA

Please use the order form included with this software.

If you're paying by a cheque drawn on a bank outside North America, please 
be sure to make your cheque payable in US dollars. Your cheque must have 
the address of a North American clearing office and a bank transit number 
printed on it. Please do not send us Eurocheques – they cannot be cleared 
outside Europe.

Note that when you send us your order – and then when we send you your 
software – two distinct post offices get to deal with the ensuing mail. It can 
take a few weeks for things to get through this system – we ask that you be 
patient. We don't fully understand why it takes less time for a package to get 
to Australia than it does to send one to Cleveland. Some things are best left as
mysteries.

Paying by Plastic

We can accept credit card payments by:

Registration Fee



Canadian users: The registration fee for GIF Construction Set Professional is 
$20.00 (CDN) plus seven percent GST, plus $5.00 shipping, or $26.40. We 
sincerely regret collecting this tax on behalf of several levels of government 
which will only squander it. If you sincerely regret having to pay it, we urge 
you to express your regret by voting in the next federal and provincial 
elections. 

American users: The registration fee for GIF Construction Set Professional is 
$20.00 (US) plus $5.00 shipping. 

Other users: The registration fee for GIF Construction Set Professional is 
$20.00 (US) plus $5.00 shipping.

Payment from countries outside Canada must be in US dollars. Please note 
that we are not able to accept purchase orders. We cannot ship software COD.

All orders are processed immediately. Please see the Terms, Conditions and 
Legal Dogma document included with this software for complete ordering 
details and all the stuff the lawyers made us say.

Note that GIF Construction Set Classic registration codes will 
not work in GIF Construction Set Professional.



Contacting Alchemy Mindworks Inc.

GIF Construction Set Professional and all its ancillary applications
are shareware. We invite you to evaluate the GIF Construction 
Set Professional package to see if it's suitable for your needs. If 
you like it, please register it. If it turns out not to be what you 
need, or if you don't feel it's worth registering, please delete it 
from your hard drive and accept our thanks for trying it out. If 
you do productive work of any sort with this software, you are no
longer evaluating it.

The best way to get in touch with us is by e-mail to 
alchemy@mindworkshop.com. Except in conditions of flood, famine or mental-
health days, our e-mail is answered within a few hours.

Technical support and customer service are available at 1-905-936-9501, 
10:00am to 5:00pm EST most business days. If you encounter our answering 
machine – it does happen occasionally – please try back later. One of the 
considerations in offering very low cost software is that we are 
unable to return calls for technical support.

If you are an unregistered user of this software, we will at our discretion assist 
you to the extent required for you to ascertain whether this software is 
suitable for your application. 

Callers who are rude, abusive or pig-headed with our technical support staff 
will wind up as demon-chow. See the section on Registration elsewhere in this 
document.

Please do not call our 800 number for technical support. The people 
who answer our sales line can put a credit card machine into warp drive, but 
they know less about software than most cats know about quantum 
mechanics. They are unable to transfer your call.

You can contact us by snail-mail at:

Alchemy Mindworks Inc.
P.O. Box 500
Beeton, Ontario
L0G 1A0
Canada

Our FAX number is 1-905-936-9502. 

We are unable to provide technical support by FAX or snail-mail.

The fabled Alchemy Mindworks BBS - poor, barnacle-encrusted antique that it 
was - has finally bit the dust. Alchemy Mindworks no longer maintains a BBS.

We ask that in contacting us you appreciate that we are a small company with
limited resources. If you have not registered this software we will not tell you 



to go to hell, but please don't ask us for half an hour of free technical support. 
We have not built the price of technical support into the cost of GIF 
Construction Set, as few users require it. We believe very strongly in not 
making everyone pay for something that only a small group needs. If our 
various governments felt the same way, our various economies wouldn't be in 
the midst of melting down.



Protection Matrix

The free and open nature of the web can often see your graphics being passed
around cyberspace like drugs in a Frontline documentary. Because it's 
exceedingly easy to copy pictures from a web page, the pictures you create 
might effectively wind up in the public domain even if they're your intellectual 
property.

A lot of lawyers are going to get new BMWs one day soon for sorting this out.

There's no way to prevent the duplication of your web page graphics entirely, 
but the GIF Construction Set Professional Protection Matrix function will help 
discourage it. It breaks a single-image GIF file into a matrix of small tiles. If 
you include these tiles in your page using the HTML code created by the 
Protection Matrix generator, the tiles will appear to form a seamless graphic. 
However, when someone uses the Save Image As function of their web 
browser to copy your graphic, they'll only get one tile, not the whole image.

A protection matrix can be defeated by someone who's sufficiently 
determined, of course -- one could, for example, just screen-capture your 
image to a new file. However, using a protection matrix increases the difficulty
in swiping your pictures considerably, and will help discourage casual image 
collectors.

There are several catches to the Protection Matrix feature. Because it creates 
multiple small GIF files to replace one original GIF file, it will increase the total 
downloadable file size involved. This will be considerably more apparent for 
files processed with an unregistered copy of GIF Construction Set Professional.
Secondly, the Protection Matrix function can only work with single, non-
animated GIF files. If you ask it to process a GIF file with multiple images, it 
will create a protection matrix from the first selected image and ignore the 
others.

Finally, a protection matrix graphic will require that you keep track of a fair 
number of GIF files, where once there was but a single file. This is, of course, 
why a protection matrix is effective at protecting your pictures.

To create a protection matrix:

Open a single-image GIF file in GIF Construction Set Professional. The 
image dimensions for the picture must be at least 96 by 96 pixels.

Select the Image block and select Protection Matrix from the Block menu.
The Protection Matrix dialog will allow you to set the characteristics of the 
matrix to be constructed. The Tile Size control determines how large each 
tile in your matrix will be. A smaller tile size will create more tiles, and as 
such an image which is more difficult to copy. Doing so will also create 
more files, however, and as such increase the download time for your 
completed image.

When a protection matrix is created, GIF Construction Set will write all the 
GIF files for your tile images and an HTML document which includes the 
code to display the tiles as a seamless graphic in your web page. This 
HTML document can include headers to make it visible in a web browser -- 



this function is handy if you'd like to see what a protection matrix looks 
like before you add it to your web page. Set the Include HTML Header 
switch on to have the Protection Matrix function include these headers, or 
off to have it omit the headers and create an HTML document with just the
text you'll need to inhale into your page. Note that if you leave this switch 
on, you can easily remove the headers later with a text editor.

Click on Save when you're ready to create a protection matrix. The Save 
As dialog that appears will point to the location and base name for your 
protection matrix files. The base name will be used to generate your tile 
files by appending numbers to it. As such, if you select a base file name of 
PICTURE.GIF, the Protection Matrix function will create new files called 
PICTURE_1.GIF, PICTURE_2.GIF, PICTURE_3.GIF and so on.

The Protection Matrix function will also create an HTML document using 
the base file name you select. In this case, it would be called 
PICTURE.HTML.

NOTE: Protection Matrix does not check for the existence of previous files 
when it creates tiles. It will overwrite existing files of the same name if they 
exist.

Once Protection Matrix is finished writing tiles, click on Done. You can now add
the matrix code from the HTML document it created to your web page. Note 
that this is actually an HTML table. You'll need to be able to edit the HTML 
document for your web page directly to do this. If you created a your 
protection matrix with the Include HTML Headers switch on, be sure to delete 
the headers before you add this code to your web page.



Overlay

The Overlay function will allow you to create animated GIF files in which one 
frame appears to float over the movement in some or all of the other frames. 
The Overlay function is extremely effective, but it does require some 
forethought to use correctly.

It also helps to understand what it's really up to.

While the example overlay shown in the Reference document seems to have 
its text appearing above the wave animation, all that this graphic really 
consists of is the text painted over every frame. As the text doesn't move and 
it's never overwritten, it appears to remain motionless and unchanging while 
the background moves.

You can use this technique with any still image and a suitable animated 
background.

To create an overlay:

1. Build your source GIF file with the still image to be overlaid followed by 
all the frames of the animated background. In fact, the position of the 
still image relative to all the other images in your GIF file is immaterial,
but putting it at the top of the list of blocks makes it easy to keep track
of.

2. Select all the blocks in your GIF file by clicking on the green Tag All 
button in the GIF Construction Set tool bar.

3. Click once on the block that will be your still overlay - this will be the 
first Image block in this example. The selection caret should appear.

4. Select Overlay from the Block menu. Click on Preview to see what your 
overlay looks like, or on OK to create a completed overlay animated 
GIF file.

There's an important catch in the foregoing. The image to be overlaid should 
have its background made transparent before you create the overlay. In the 
case of the small example overlay shown in the Reference document, this has 
allowed the text to appear without a rectangular background, which would 
otherwise have obscured the animated wave. If you fail to do this, the Overlay
function will warn you that there's no transparency enabled in your overlay 
image.

The Overlay function cannot be used with GIF files having local palettes.

It's worth noting that Overlay only affects those animated frames which are 
selected. Any frames which are not selected will be copied un-overlaid to the 
new GIF file being created. You can use this feature to overlay more than one 
image, or to create overlays which appear and disappear over the course of 
the complete animation.






